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Overview

This user guide describes how the Senturus Analytics Connector is used from Power BI after it
has been installed and configured.

Please refer to the Senturus Analytics Connector Installation and Configuration Guide for
instructions on installing and configuring the Analytics Connector.

The Analytics Connector is designed for Power Bl and has been tested against different versions,
including both Power Bl Desktop and Power Bl Gateway on Windows starting with the August
2018 release. For optimal stability and performance, it is recommended that you keep your Power
Bl software fully updated.

© 2019-2022 Senturus, Inc. 3



Connecting to Analytics Connector Server

You don’t connect to Cognos directly from Power Bl Desktop or Power Bl Gateway. Instead you
connect to the Analytics Connector server and the Analytics Connector server connects to a
Cognos dispatcher on your behalf. For more information, please refer to the “Architecture
Overview” section in the Senturus Analytics Connector Installation Guide.

You can connect to the Analytics Connector Server using either the Power Bl built-in SQL Server
database connector or the Senturus custom data connector.

Senturus highly recommends adopting the Power BI built-in SQL Server connector. See the
Legacy Documentation section for information on the custom connector.

Power Bl SQL Server Connector vs Custom Connector

Starting from version 5.0, you can connect from Power Bl Desktop and Power Bl Gateway to the
Analytics Connector via a SQL Server database connection.

If you migrated from version 4.x, you may still use our custom Data Connector to connect. All your
old reports and data sources will continue working.

Compared to the custom data connector, the SQL Server connector gives you the following
advantages:

1. No need to install Analytics Connector ODBC client?.
2. No need to copy custom Data Connector (.mez files).

3.  Use Windows authentication from Power Bl Desktop to Analytics Connector server to
Cognos.?

4. More Power BI functions are supported, e.g. guery cancellation.

See the Legacy Documentation section for information on the custom data connector.

1 You still need to install SQL Server Native Client 11 or above on your client computer.

2 Both Power BI Desktop and Cognos server must be secured by the same Active Directory service.
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Conecting via SQL Server Connector?

To begin, open Power Bl Desktop and select Get Data -> SQL Server from the ribbon. “SQL
Server database” dialog pops up.

In Server input box, Type in hostname of IP of Analytics Connector server.

In Database (optional) input box, type in database name given by your Analytics Connector
administrator when he/she mapped a Cognos package or data module to it.

Check DirectQuery and (optionally) uncheck “Include relationship columns” and check “Navigate
using full hierarchy”.

The Senturus Analytics Connector supports both Import and DirectQuery modes. For the sake of
simplicity, we will only use DirectQuery in this section. For more information regarding when and
how to use Import vs DirectQuery mode, please refer to the next section.

Then click on OK button.

SQL Server database

Server(D)
win03.example.com
Database (optional)

GO Sales (guery)
Data Connectivity mode (1)
O Import

® DirectQuery

4 Advanced options

Command timeout in minutes (optional)

SQL statement (optional, requires database)

[ Include relationship columns
¥ Mavigate using full hierarchy
[ Enable SQL Server Failover support

g (o

3 Make sure you have installed the SQL Server Native Client 11 or above in order to use SQL database
connection. The download can be found here: https://www.microsoft.com/en-
us/download/details.aspx?id=50402
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You can use either Windows authentication* or Database authentication (by providing your
Cognos login user name and password).

SOL Server database X
Windows win03.example.com;GO Sales (query)

User name

Database
cagnos

Microsoft account Passward

Select which level to apply these seftings to

win03.example.com;GO Sales (query) -

o

NOTE: Power Bl desktop will securely store these credentials and skip this dialog if you have
entered before.

To manage or delete the stored authentication information, go to File 2 Options and settings 2>
Data source settings.

You may see a warning popup if SSL is not enabled on the Analytics Connector server. Click OK
to dismiss this message.

Encryption Support
We were unable to connect to the data source using an encrypted

connection. To access this data source using an unencrypted
connection, click OK.

If your database is mapped from Cognos package, you will see the following objects in the
Navigator panel:

1. Each namespace is mapped to a schema. You will see some system schemas when
connecting to a real SQL server database.

4You can only use Windows authentication when your Administrators have successfully configured
Windows Authentication support on Senturus Analytics Connector server.
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2. Each query subject is mapped to a table.

3. Each query item will be mapped to a column. Plus a dummy column, AAA_LINK, in each
mapped table. See Creating Relationships regarding more informaton.

4. If you have standalone calculations under a namespace, each calculation is mapped to a
column under a special table AAA_CALCULATIONS (table name is configurable in Data Source
Configuration tool). You can use this special table the same as other query subject mapped
tables.

5. If you configured schema to report folder mappings, each report will be mapped to a table
under a schema. However, you cannot use report mapped tables as regular tables, please refer to
Working with Reports for more information.

If your database is mapped from a Cognos data module, you will see following objects in the
Navigator panel:

1. Only one schema with the same name as your data module. You will see some system
schemas when connecting to a real SQL server database.

2. Each table in a data module is mapped to a SQL Server database table.

3. If you configured schema to report folder mappings, each report will be mapped to a table
under a schema. However, you cannot use report mapped tables as regular tables, please refer to
Working with Reports for more information.

Select only tables you need to pull columns from and click on Load button.

Hint: You don’t have to wait table preview to be loaded before clicking on Load button.
Additionally, you can uncheck the Display Options -> Enable data previews option to skip
previews.
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Navigator
£ | Products &
Display Options ~ DJ AAA_LINK Product line code Product line Product type cod
b Return: Only selected items 1 994 OQutdoor Protection
~ ) ~
b root Enable data previews 2 551 Camping Equipment
3 5593 Personal Accessories
i h
Sales (queny) [15] 4 583 | Personal Accessories
] lEl Branch 5 993 Personal Accessories
o |E| CALCULATIONS 6 993 Personal ACCessories
O lEl Order 7 583 | Personal Accessories
] lEl Order method 8 584 Outdoor Protection
9 991 | Camping Equipment
] E Parameterized Products .
10 991 Camping Equipment
O E Parameterized Products 2 11 554 Qutdoor Protection
v |E| Products 12 594 Outdoor Protection
O Retailer type i3 894 Outdoor Protection
o IEI Retailers 14 584 Outdoor Protection
15 584 Qutdoor Protection
\/ |E| Sales
16 991 | Camping Equipment
| E Sales staff 17 991 Camping Equipment
+ E Time 18 591 Camping Equipment
[m] |E| Time (close date) 19 5591 Camping Equipment
[m] lEl Time (ship date) 20 995 Golf Equipment
21 584 Outdoor Protection
[m] |E| User
22 5585 Golf Equipment
. ; v
b Sales target (query) v 23 583 | Personal Accessories
I =ys < >

Select Related Tables Load Transform Data | | Cancel |

Power BI will then inspect the selected tables and load them into a report.

Apply query changes

Evaluating...
. Time
Evaluating...
.t Products
Evaluating...
.t Branch
Evaluating...

Cancel

After loading tables into Power BI, you need to create relationships among tables before building
report pages. Please refer to Creating Relationships for more information.
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Import vs DirectQuery Mode

Differences

The Senturus Analytics Connector supports both Import and DirectQuery modes. The bottom line
is the Senturus Analytics Connector sever has no clue if a query is sent for Import or DirectQuery.

Basic Difference

The basic difference between Import and DirectQuery mode is, Import mode extracts the data
from your database and pulls it into the Power BI report, while DirectQuery leaves the data in your
database and sends queries (usually grouped and aggregated) to pull the information as needed.

Other things to note. Import gives you the full suite of transformation and data manipulation in the
Desktop, but there is a 1 GB limit to the report if you plan on publishing to the PBI Service.
DirectQuery leaves the data in your database, so the data will always be live/up-to-date and there
is no need to refresh.

Performance

Import is usually faster than DirectQuery, and it reduces your database workload because
everything is already imported into a Power Bl report but this is not always true. Results vary
depending on your live database performance and the size/structure of imported data.

Security

When you use DirectQuery, the Senturus Analytics Connector server logs into Cognos on behalf
of you, so all Cognos securities will be enforced, for example package/report access security, and
row level security built-in your Cognos model and reports.

When you use Import mode, Cognos securities will be applied only when you import the data.
Once data is imported into Power BI, they are disconnected from Analytics Connector/Cognos, so
all data will be open to anyone that has access to this Power Bl report until you set up row-level
security in your Power Bl report.

Relationship Setup

Whether your Cognos models (FM packages, data modules, cubes) expose primary and foreign
keys also affects your options of which one to use. If there are no join columns between tables
(derived Cognos query subjets, hierarchies, etc.), then you cannot join imported tables in Power
Bl. We will dicuss this in detail later. There is some workaround though, please refer to Join
Tables without Key Columns for more information.
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Other

The last difference is, Import mode is only available when you are using the SQL Server
connector®.

Import Mode is generally not recommended. It bypasses any Cognos row-level security that’s
been established so any data access logs and audit trails are either lost or need to be rebuilt in
Power BI. Relationships are also not as straightforward to make if your Cognos models don’t
expose primary and foreign keys (See Relationship Setup). Lastly, measures in your Cognos
DMR models may not work properly when in Import mode. Measures are dependent on the
aggregation level being applied. When using Import mode, the correct aggregation level cannot be
deduced and the Connector uses the default aggregation level set in Framework Manager which
may lead to skewed results.

If you find yourself needing to use Import mode, the recommended approach is to create a
Cognos list report that pulls all the data points you need at the appropriate aggregation level for
your calculations. Once this report is in place, use the RunReport function to use the report as
your data source.

Composite Mode

Starging from the December 2020 release, Power Bl supports composite models, which means
you can mix DirectQuery and Import tables/queries in one report. You still need to make sure
PK/FK are available when joining from/to an imported table/query — otherwise, they have to be
DirectQuery tables.

Import Tables

We already showed you how to connect tables via DirectQuery mode in the previous section.
Importing tables follows the exact same steps, except you need to check the “Import” option.

5You can setup an ODBC DSN using SQL Server native client 11.0+ or Senturus Analytics Connector
ODBC client, then import tables/queries using Power Bl ODBC connector. This is how it works in
previous release before V5. This will still work, but we recommend you use SQL Server Database
connector in Import mode for all new reports.
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SQL Server database

Server ()

localhost
Database (eptional)
Data Connectivity mode (i)

O DirectQuery

4 Advanced options

Command timeout in minutes (optional)

SQL statement (optional, requires database)

Include relationship columns
¥ Navigate using full hierarchy

Enable SOL Server Failover support

Importing Queries

g [ |

You can also specify a query to import instead of individual tables.

Within the “SQL Server database” page, type in “Database” (it's now mandatory when importing
a query), and put a valid select script in “SQL statement (optional, requires database)” box.

You can use standard SQL select statements here, including filter, group, aggregates, functions,
even sub-queries. We cannot guarantee it will support all select statements, so keep it as simple

as possible.

The schema, tables and columns are derived from your Cognos model, as you can see during the
importing tables page. Also, please use AAA_LINK to join your tables (see screenshot for

example).

© 2019-2022 Senturus, Inc.

11



SQL Server database

Server(D)

lacalhost
Database

Great Qutdoors Sales (cube)

Data Connectivity mode (0
* Import
O DirectQuery

4 Advanced options

Command timeout in minutes (optional)

SOL statement (optional, requires database)

select m.*, p."Product line", p."Product type", p."Product®, y."¥ear", y."Quarter”, y."Month"
from "great_outdoors_sales_en”."Measures” as m A
join "great_outdoors_sales_en™."Products” as p on (m.AAA LINK = p.AAA_LINK)
join "great_outdoors_sales_en™."Years" as y on {m.AAA_LINK = y.AAA LINK)
where y."Year" between '2018"' and '20813'

< >

O Include relationship columns

[ Navigate using full hierarchy
[ Enable SQL Server Failover support

After clicking OK, this query will be sent to the Analytics Connector server and a preview page will
display the result once data is returned. Click “Load” to import it into Power Bl report or
“Transform Data” to do more transformation before loading.

localhost: Great Outdoors Sales (cube)

AAA_LINK Revenue Product cost Product plan Branch expense plan Quantity sold Unit cost Gross profit Profit margin % Re1

1 18995361 104562.9 2818.444189 null 15795 6.62 85390.71 0.44953455
2 24088799 18025598 3075.567182 null 27229 6.62 60632.01 0.25170209
3 19322847 106337.06 2856.811802 null 16063 6.62 8689141 0.44968223
4 17514719 L6754.54 2733.5805 null 14517 6.62 79382.65 0.45065088
5 19422684 107402 88 2952939504 null 16224 6.62 86823.96 0.44702349
6 29197889 218930.02 4563.642187 null 33071 6.62 7304887 0.25018545
7| 20524379 113155.66 2749.58619 null 17093 6.62 9208813 0.44867682
8 20643559 113857.38 2864 817838 null 17199 662 92578 61 044845158
9 19255354 105946.48 2704.112935 null 16004 6.62 8664746 0.44985713
10 22571845 125018 7 3106758509 null 18885 662 10069975 04451295
11 20800552 114455.8 2861.678251 null 17290 6.62 93545.72 0.4497271
12 18724354 10302044 2572.886108 nulf 15562 6.62 842231 04458051
13 30558264 154801.4553 5186.517656 null 34614 | 447222093 15127536 0.49503912
14 237334.98 129368.04 3165.185872 null 19542 6.62 107966.94 0.45491373
15 25716183 130341.0198 3716.975083 null 29109 | 447768799 127279.05 0.48493757
16 22670752 123767.52 3316.171447 null 18696 6.62 1029404 0.45406618
17 22501143 12275466 2811.693524 null 18543 6.62 102256.77 0.45445145
18 224654.79 122827 48 3028.743411 null 18554 6.62 101867.31 0.45335858
15 23295245 126859.06 3223.113859 null 19163 6.62 106093.4 0.4554254
20 217680.62 118471.52 2766.177037 null 17896 6.62 59209.1 0.45575532

o The data in the preview has been truncated due to size limits,

< >

Load _ransformData| | Cancel |
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Once the query is imported, you click on the “Data” tab to view the data and make more
transformation as needed.

Untitled - Power Bl Desktop

File Home Help Table tools Column tools

Qs pe e || § % 9 B B oo e
Structurs Formatting Bropartiss

X

= AAA_LINK | ~ | Revenue |~ | Productcost |~ | Product plan |~ | Branch expense plan |~ | Quantity sold |~ | Unit cost |~ | Gre
4340 12288325 4342532 1763235257359 25217 156

qg 4341 13172145 5302192 1873137141855 27052 198
4342 13821645 56506.8 19186.607458764 28830 156
4343 13519255 5440076 1846221307812 27806 196
4344 12014355 48504.12 16838.65700112 24747 1%
4345 43300 16973.6| 5913.81305308 8660 156
4348 37545 1471754 448705763334 7509 196
4347 30480 11234316 4183.5224558 6036 156
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Creating Relationships

Power Bl requires relationships between tables, but Cognos typically does not present primary
key and foreign keys at the business user view.

The Analytics Connector injects AAA_LINK columns into the tables so you can build relationships
between them even when there are no PK/FK columns. The Analytics Connector ignores joins
formed by AAA_LINK columns when passing queries to Cognos for execution.

NOTE: It is very important that you create the relationships as described so that Power Bl sends
the appropriate queries to Cognos!

Join DirectQuery Tables

When joining DirectQuery tables, always use AAA_LINK columns because you want to let
Cognos decide the correct relationship. Even when you do have business PK/FK columns, please
still join them by AAA_LINK columns as this will guarantee correct results and better
performance.

Start by dragging the AAA_LINK column in the fact table to the AAA_LINK table in the dimension
table.

ﬁ Branch ey m Sales [ m Time o
T AAA_LINK < S AAALINK ) T AAALINK
Address 1 Z Gross profit Date
Address 1 (multiscript) E Planned revenue Z Day ki
Address 2 Z Product cost Z Day of the month
Address 2 (multiscript) E Quantity Z Day of the week
Z Branch code z Revenue Z Day of the year

lapse ™~

Collapse

Collapse

9

ﬁ Products

¥ AAA_LINK

Z Base product number
Discontinued date
ntroduction date
Product

Collapse ™

In the Create Relationship dialog, make sure the cardinality is set Many to one (*:1).
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Check the box next to Assume referential integrity.
Click OK.

Hint: You don’t have to wait for Power Bl to populate preview contents before clicking the OK
button. If Power Bl shows an error dialog because it hasn’t finished probing the tables yet, you
can simply dismiss and ignore the error, as Power Bl will create relationships as you specified
anyway.

X
Create relationship
Select tables and columns that are related.
Sales -
AAA_LINK Quantity Unit cost Unit price Unit sale price Revenue Product cost Gross profit Pl
1 145 4045 85 85 12410 5905.7 55042
2 &8 4273 £58.3 85.3 7144 341.54 372.56
3 23 4136 73 73 1679 951.28 72772
£ >
Eranch -
AAA_LINK Branch code Address 1 Address 1 (multiscript) Address 2 Address 2 (multiscript) City
1 40 55 Rue Rothschild 55 Rue Rothschild null null | Gené
2 39 ledleser Strae 7 | Jedleser Strafe 7 null null  Wien
3 38 Interleuvenlaan 2 | Interleuvenliaan 2 null null Hever
< >
Cardinality Cross filter direction
Many to ene (%1) T Both -
¥ Make this relationship active Apply security filter in both directions
¥ Assume referential integrity Learn more
OK Cancel

Repeat these steps until the fact table has relationships to all dimension tables.

If you have multiple fact tables, chain these fact tables based on granularity and link the highest
level fact table to dimension tables, as shown in the diagram below.
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ﬁ Sales O

AAA LIMNK

ross profit

R e |

Planned revenue
Product cost
At

Collapse
*
fN‘. Branch ol L“W ‘
1 ﬁ Time

AAALINK

9
9

D
=
E
>
=
=

m Sales target

AMA_LINK * 4

Address 1

Address 1 [multiscript)

4

Address 2 1 2 Salestarget

Address 2 (multiscript) P
Callapse
Branch code

City

-~ ——x

Collapse

9

m Products

ARALINK

Base product number
Discontinued date
ntroduction date

Product

Collapse ™

After creating relationships, change to the Report view and create your report.

Join Import Tables

When joining import tables, always use your business PK/FK columns. Using AAA_LINK to join
import tables will yield incorrect results. Why? Because once the table/query data is loaded into
Power BI, they are stored as different tables within Power Bl. If you join tables by AAA_LINK
(which are simply sequential numbers in each table/query), the numbers will be wong.

Join DirectQuery and Import Tables
When joining between DirectQuery and Import tables, always use your business PK/FK columns

too. Power Bl will query DirectQuery first then join the result to the import table using the
relationship you defined, so these relationships must be joined by business PK/FK columns.
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Join Tables without Key Columns

What if your table does not have business PK/FK columns and you still need to join it with an
import table, or this table itself is an import table? You can borrow ones from other tables using a
query.

You can import a query, and “borrow” FK columns from other tables by using a select statement
like below:

select p."Product",
y."Month",
sum(m."Quantity sold") as "Quantity sold",

sum (m."Revenue") as "Revenue",

sum (m."Product cost") as "Product cost",
sum(m."Gross profit") as "Gross profit",
sum(m."Sales target") as "Sales garget"

from "great outdoors sales en"."Measures" as m
join "great outdoors_sales en"."Products" as p on (m.AAA LINK = p.AAA LINK)
join "great outdoors sales en"."Years" as y on (m.AAA LINK = y.AAA LINK)
where vy."Year" = '2010"'
group by p."Product",
y."Month"

Then you can join this query to other import tables like below:

Products i) ﬁ Query1 ot = .
1 Years o .
AAA_LINK 3 Gross profit
AAA_LINK
Product Month Month
Aon
Product - Category Code Product Month - Cat Cod
donth - Category Code
Product - Member Description Y Product cost Month - Memb TD inti
_ 1 —— ) 2%k R Jeit| 4 — q onth - Member Description
Product line ? Qua tity sold 1 Quart
uarter
Product line - Category Code 7 Revenue Quarter - Cat ~
uarter - Category Code
Product line - Member Descrip... 2 Sales garget

Quarter - Member Description
Product type
Year
Product type - Category Code X
‘fear - Category Code
Collapse Collapse ™ s
: Collapse
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Cognos Parameterized Tables and Reports

You cannot use parameterized tables (mapped from Cognos parameterized query subjects) or
report mapped tables as regular tables. Power Bl will not be able to import them if you select any
parameterized tables or report tables:

Create connections

cked by failures with other queries.

/ failures with other gueries.

Loading blocked by failures with other queries.

When using parameterized query subjects in a Cognos report, or executing a pre-defined Cognos
report with prompts, users will be prompted to enter parameter values but you cannot provide
parameter values in Power Bl for regular database tables.

The answer is to write custom SQL and use OpenTable and RunReport functions to feed
parameter values to Cognos.

Working with Parameterized Tables

The Analytics Connector supports working with parameterized tables in Power Bl by using the
OpenTable function, which lets you pass parameter values to Cognos.

Example:

select p."Product line", p."Product type", sum(s.Revenue) as Revenue,
sum(s.Quantity) as Qantity

from

OpenTable (
"Sales (query)"."Parameterized Products",
"p product line code"="[991, 992, 993, 994, 995]",
"p_Product Line"="'Golf Equipment'",
"p Date"="{d '2010-01-01"'}",
"p Datetime"="'2010-01-01 19:00:00""

) as p

join "Sales (query)"."Sales" as s on (p.AAA LINK = s.AAA LINK)

group by p."Product line", p."Product type"

© 2019-2022 Senturus, Inc. 18



Instead of selecting from a table directly, you use the OpenTable function (a tabular function) to
invoke the parameterized table and join it to other tables. The first parameter "schema
name"."table name" iS the Cognos table name. This is followed by zero or more Cognos
parameter name-value pairs separated by commas. For more information, please refer to
Function Syntax.

To begin, open Power Bl Desktop and select Get Data -> SQL Server from the ribbon. “SQL
Server database” dialog pops up.

In Server input box, Type in hostname of IP of Analytics Connector server.

In Database (optional) input box, type in database nhame given by your Analytics Connector
administrator when he/she has mapped a Cognos package or data module to it. Please note,
Database is mandatory in this case.

Check DirectQuery and (optionally) check “Navigate using full hierarchy”.

Expend “Advanced options”, put custom SQL in “SQL Statement (optional, requires
database)” box.

© 2019-2022 Senturus, Inc. 19



Click OK.

SQL Server database

Server ()

localhost

Database (opticnal)
GO Sales (guery)

Data Connectivity mode (0
Q Import
* DirectQuery

4 Advanced options

Command timeout in minutes (optional)

SQL statement (optional, requires database)

select p."Product line", p."Product type®, sum(s.Revenue} as Revenue, sum(s.Quantity) as Qant:
from A
OpenTable
"Sales {query)”."Parameterized Products”,
"p_product line code"="[991, 992, 993, 594, 995]",

< >

¥ Include relationship columns

¥ Mavigate using full hierarchy
[ Enable SOL Server Failover support

o

A data preview window will display. Click Load.

localhost: GO Sales (query)

Product line Product type Rewvenue Qantity

Golf Equipment | Golf Accessories | 51514343 88 3115747
Golf Equipment | Irons 254814338 351445
Golf Equipment | Putters 1061842714 1284570
Golf Equipment | Woods 313558414 7 317539

Load Transform Data | | Cancel

You can now use the columns from the Fields tab to build the report.
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Untitled - Power Bl Desktop

File Home Insert Modeling Wiew Help Format Data / Drill
R! Excel E @ Transform data « d:h'_ Mew visual [‘5@?
v &
Get dﬁ Power Bl datasets [%g [% Refresh =] Text box |_—| Publish
<& | dataw [ﬁ SQL Server [I} More visuals ~
Clipbozrd Data Queries nsert Calculations |  Share -
A 7 e
il e < < Fields >
< Back to report ‘
. . =
Product line Qantity  Revenue < @ £ search
=
- I o
Golf Equipment | 5113701 726,411,367.89 g g~ B Queryl
Golf Accessories | 3119747 51,514,343.88 br] g.
Irons 301445  254,814,337.09 g L Product line
Putters 1284570  106,184,271.37 = @  Product type
Woods 317039 313,898,414.65 %3 Qantity
Total 5113701 726,411,367.89

# = Revenue

Page 1of 1 Storage Mode: DirectQuery (click to change)
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Working with Reports

The Analytics Connector supports working with Cognos reports in Power Bl by using the
RunReport function, which lets you pass parameter values to a Cognos report.

The Analytics Connector only supports list style Cognos reports, not crosstabs or charts.

Example:

Select *
From
RunReport (
"Connector Reports"."Parameter Report",
"p product line code"="[991,992,993,994,995]",
"p Product Line"="'Golf Equipment'",
"p Date"="'2010-01-01"",
"p Datetime"="2010-02-01 19:00:00"
) as "Report"

The first parameter "schema name"."report name" is the Cognos report. This is followed by
zero or more Cognos parameter name-value pairs separated by commas. For more information of
about RunReport function, please refer to Function Syntax.

To begin, open Power Bl Desktop and select Get Data -> SQL Server from the ribbon. “SQL
Server database” dialog pops up.

In Server input box, Type in hostname of IP of Analytics Connector server.

In Database (optional) input box, type in database name given by your Analytics Connector
administrator when he/she mapped a Cognos package or data module to it. Please note,
Database is mendentary in this case.

Check DirectQuery and (optionally) check “Navigate using full hierarchy”.

Expend “Advanced options”, put custom SQL in “SQL Statement (optional, requires
database)” box.
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Click OK.

SQL Server database

Server ()

localhost

Database (opticnal)
GO Sales (guery)

Data Connectivity mode (0
Q Import
* DirectQuery

4 Advanced options

Command timeout in minutes (optional)

SQL statement (optional, requires database)

Select *
From A
RunReport (
"Connector Reports™."Parameter Report",
“p_product line code"="[991,992,993,994,595]", v
"p_Product Line"=""Golf Equipment'",

¥ Include relationship columns
[ Mavigate using full hierarchy
[ Enable SOL Server Failover support

A data preview window will display. Click Load.

o X

localhost: GO Sales (query)
Product line code Product line Product type code Product type Year Revenue

585 | Golf Equipment 868 | Irons 2010 46542811

995 | Golf Equipment 969 | Woods 2010 | 5138304.03

585 | Golf Equipment 970 | Putters 2010 2455044

895 | Golf Equipment 971 | Golf Accessories 2010 | B64227.83

Load Transiom Data | [ cancel |

You can now use the columns from the Fields tab to build the report.
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Untitled - Power Bl Desktop

File Home Insert Modeling View Help

E:IE |_—ﬁ Excel E @ Transform data ~

Get |jn@ Power Bl datasets [%9 e D:a Refresh

§§ data w [E SQL Server
Clipboard Dats Qusriss

[ul

&5

< Back to report ‘

Product line 2010 Total
Golf Equipment | 13,115,856.96 13,115,856.96
Golf Accessories 864,227.83 864,227.833
Irons 465428110 4,654,281.10
Putters 2,459,044.00 2,459,044.00
Woods 5,138,204.03  5,138,304.03
Total 13,115,856.96 13,115,856.96
Page 1 of 1
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Format Data / Drill

d]_",_ MNew visual [[]j],]\

i
[E] Text box d Publish
[l} More visuals «
nsert Calculstions |  Share o
< < Fields ’
=] = O search
@
=
I o
7 N~ E Queryl
a2 -
g‘ v Product line
7]

O = Product line code
< Product type

O Z Product type code
# X Revenue

# Z VYear

Storage Mode: DirectQuery (click to change)
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Working with Power Bl Parameters

In your Power Bl ODBC queries, you can replace the static values with Power Bl parameters to
create dynamic values that can be easily changed.

After configuring a Parameterized Table or Report query, click Edit Queries to bring up
‘ﬂ* the Power Query Editor.

Edit
Queries *

Click Manage Parameters to display the Parameters dialog.

Create a new parameter.

Parameters

Mew Name
[E Start Date x Start_Date
Description

Start date to pass to the parameterized table

*| Required
Type

Date -
Suggested Values

Any value -

Current Value
1/1/2010

oK Cancel

Next, edit the query to include the parameter in the SQL statement. You may need to format non-
text data types using M language functions in order to append them to the statement.

The below example formats a date parameter to text and appends it to the SQL statement.
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Queries [2] < = Odbc.Query(“dsn=Senturus Colo .45", "Select * From (#(1f)OpenTable(#(1f) ""Sales

(guery)"".""Parameterized Products"", #(1f) ""p_product line code""=""[991, 992, 993, 994, 995]"", #
(1f) ""p_Product Line""=""'Golf Equipment'®",#(1f) ""p_Date""="""" & Date.ToText(Start_Date, "yyyy-MM-
& Queryt dd") & "'"v, #(1f) ""p_Datetime""=""'2012-21-01 19:00:00'""#(1))#(1f)) as ""Parameterized Table""")|

g

NOTE: Double quotes must be escaped by using two sets of double quotes.

=X

E,TL Click Close & Apply.
Close &
Apply >

To change the Parameter value(s), select Edit Parameters under Edit Queries.

4 D o 11 |

7 o A
Edit Refresh Mew |
Queries ~ Page~ W

¢ [ Edit Queries

t :c'. Data source settings
1 Edit Parameters

] Edit Variables

The Enter Parameters dialog will display with a list of configured parameters and their values.

Fill in new values and click OK.

Enter Parameters

Start_Date (1
12/31/2000

OK Cancel

Click Apply Changes if the data does not refresh.

Clipboard External data Insert

1 There are pending changes in your queries that haven't been applied. Apply changes
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Function Syntax

Both OpenTable and RunReport functions use the same syntax.
Syntax

Both OpenTable and RunReport function use the following syntax:

OpenTable ( "Schema Name"."Table/Report Name"(, "Parameter"="value", ...) )

The first parameter is a table identifier, using standard SQL syntax. All identifiers are case in-
sensitive and the schema name can be omitted if the table name is unique across schemas.

Any additional parameters should be defined as hame-value pairs, separated by commas. Name
and values should be surrounded by double quotation marks.

Parameters

Use parameter name in place of "Parameter"” for the Cognos connector.

Values
All values should follow the SQL/ODBC standard.

Only plain string representation is allowed for numeric values. Formatted representations such as
1,200.00 with thousand separators, (15) for -15, or 50% for .5 are not supported.

For string values, single quotation marks are used around the value. For example, 'Golf
Equipment’ or 'Sam"s Club'.

For date/time/timestamp values, use the ODBC standard format. For example {d '2010-01-01'} or
ISO 8601 standard format, 'YYYY-MM-DD' for date, 'hh:mm:ss' for time and 'YYYY-MM-DD
hh:mm:ss' for timestamp.

An array of values is passed using brackets. For example:
e "product line code"="[991,992,993,994,995]"

The syntax for a Range parameters is represented by a 2 element array. For example:
e "YearRange"="[,2019]" — All years less than or equal to 2019

o "YearRange"="[2015,]" — All years greater than or equal to 2015
e "YearRange"="[2015,2019]" — Years between 2015 and 2019
Character escaping

Certain characters must be escaped.

For single quotes within a string value, use two single quotes to escape a single quote inside the
string.

Double quotes in parameter name and values need to be escaped with two double quotes.
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Passing multiple values to a parameter

A Cognos parameter may accept multiple values, for example [Product line code] in (?p_Product
line code?). To specify multiple values in your function, put multiple values in a pair of square
brackets ([]) and separate each value by a comma (,) just like CSV format.
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Publish to powerbi.com

After creating a Power Bl report, you can publish it to powerbi.com and share it with others.
Simply click on Publish button and select a destination you want to publish.

In order to allow powerbi.com access to your on-premises data, you need to install and configure
Power Bl Gateway. If you use the custom connector in your Power Bl report, you need to install
Senturus Analytics Connector client on the computer where Power Bl Gateway is running and
copy custom connector file to it. For more information, please refer to Senturus Analytics
Connector Installation Guide.

To publish a Power BI report from Desktop to powerbi.com, follow steps below:

1. Connect to the Senturus Analytics Connector server using SQL Server database connection
or custom data connector.

SQL Server database

Server (1)
internal-bil
Database (opticnal)

GO Sales (analysis)

Data Connectivity mode (1)
O Import

® DirectQuery

S [

Or

Senturus Analytics Connector

Server (1)
internal-bil

Port (@)
5432

Database ()

GO Sales (an alysis)l

Data Connectivity mode ()
O Import

* DirectQuery

S [ oo |

2. Create your visualization, save Power Bl report, click Publish button.
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3. Select a destination and click on Select.

X

Publish to Power Bl
Select a destination

Search

My workspace ~

Cognos Report Insights

Intranet

MWD Senturus

Senturus Analytics for Salesforce ~

L SNCHCRUE. S

e

4. Click on “Open ‘your report name.pbix’ Power BIl” in the success dialog:

Publishing to Power BI

~" Success!

Open "Sales (analysis).pbix' in Power B

Did you know?
You can create a portrait view of your report, tailored for mobile phones.

On the View tab, select Mobile Layout. Learn more

aly

Gotit

5.  You will see an error if you did not setup a gateway using the same connection settings you
entered in step 1 before.

Sales (analysis}

= [™ File ~ > Export ~ |# Share K ChatinTeams Q Getinsights

@ Home ':9 There is no gateway to access the data source Extension. Show details
3% Favorites >

(© Recent b,

=+ Create

O Datasets
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6. Go to the workspace, hover over your mouse right to the newly created data set, and click on

“More options” button, then “Settings”:

= AL_as 5UL Kerberos
Learn

GO Sales (query)
Workspaces >
GO Sales (query) - 5QL - Basic Auth

My workspace N
GO Sales (query) data connector postgres
RunReport

*Sales (analysis) O L

Sales (query)

Security
Rename
Settings
Download the .pbix
Manage permissions

View lineage

7. Click on the arrow button under the Actions column and click on “Manually add to gateway”. If
you added a data source using the same connection settings, you will see a drop-down list of data
sources instead of “Manually add to gateway” button. In that case, you can select a data source

for your dataset without creating a new data source.

Settings for GO Sales (query)

N\ One or more cloud data sources for this dataset have been deleted.

Recreate cloud data sources

Refresh history
» Dataset description

4 Gateway connection

To use a data gateway, make sure the computer is online and the data source is added in Manage
gateway (standard mode), please select the corresponding data sources and then click apply.

Use an On-premises or VNet data gateway

Status

Gateway Department Contact information

(P bil.gateway xgao@senturus.com

s. If you're using an On-premises data

Actions

() Not configured correctly 8w

Data sources included in this dataset:

Extension{"extensionDataSourcekind":"SenturusAnalyticsConnector”,"exten
(%) sionDataSourcePath":"[\"server\"\"internal-bi1.senturus.com\"\ "port\":\"54
32\"\"databasze\"\"GO Sales (query)\"}"}

Manusally add
1o gateway

8. Now you can create a data source under a particular gateway.

If you are using the SQL Server connector in your report, you can create data sources just like
you do for other SQL server data source except that you have to pick Basic “Authentication

method”.

Here is an example:
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Data Source Settings ~ Users

Data Source Name

GO Sales (analysis)

Data Source Type

SQL Server -
Server

internal-bi

Database

Sales (analysis)
Authentication Method

Basic v

The credentials are encrypted using the key stored on-premises on the gateway server, Learn mors

Username

cognosembed @senturus.com

Password

[ skip Test Connection

»Advanced settings

Add Discard

If you are using the custom connector, you need to select “Senturus Analytics Connector” from the
Data Source Type list. Here is an example
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Data Source Settings ~ Users

Data Source Name

GO Sales (analysis)
Data Source Type

Senturus Analytics Connector ~
Server

internal-bi1
Port

5432
Database

ISaIes (analysis)

The credentials are encrypted using the key stored on-premises on the gateway server. Learn more

Username
cognosembed @senturus.com
Password

[ skip Test Connection

»Advanced settings

Add Discard

Please note, you need to type in the exact server, port and database here as you have in Power
Bl Desktop (case sensitive). Please refer to step 1.

9. After creating data source, go back to data set settings, map the data source and click on
Apply.
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Settings for Sales (analysis)

A One or more cloud data sources for this dataset have been deleted,
Recreate cloud data sources

Refresh history

»Dataset description

4 Gateway connection
To use a data gateway, make sure the computer is online and the data source is added in Manage Ga
gateway (standard mode), please select the comresponding data sources and then click apply.

If you're using an On-premises data

Use an On-premises or VNet data gateway

[ ]
Gateway Department Contact information  Status Actions
® (i bil.gateway xgao@senturus.com () Running on INTERNAL-BI1 £

Data sources included in this dataset:

. Extension{"extensionDataSourceKind":"SenturusAnalyticsCo Maps tor

~) nnector”,"extensionDataSourcePath™: "\ "server\ ™\ "internal-b |GO Sales (analysis) v|
IV porth,"\"5432Y" \"database\"\"GO Sales (analysis)\"}"} Y

Apply Discard

10. Finally, you can open your report and/or create new reports with your dataset.

© 2019-2022 Senturus, Inc.

34



Legacy Documentation

This section is for the custom connector. While the custom connector is still supported, Senturus
highly recommends using the built in SQL Server Connector.

Install the Custom Connector

Our custom Data Connector wraps the Analytics Connector ODBC client and enables DirectQuery
capabilities.

To use the custom Data Connector, follow steps below:

1. Install Senturus Analytics Connector ODBC client. The latest ODBC client can be found at
Senturus Analytics Connector - Customer Resources.®

2. Copy the Custom Data Connector “SenturusAnalyticsConnector.mez” from Analytics
Connector server (under “<install_root>\Power BI” folder) to you Power Bl Desktop computer
(under “{Userf\Documents\Power Bl Desktop\Custom Connectors” folder).

If your Senturus Analytics Connector server administrators made some changes using Senturus
Data Source Configuration tool or Service Configuration tool, for example mapped a new
database to a Cognos package, or moved Analytics Connector server to a new host, a new
“SenturusAnalyticsConnector.mez” file will be generated and you need to copy it again.

3. Start Power Bl Desktop, go to Files -> Options and Settings -> Options, select Security on left
panel, and under “Data Extensions” option, check “(Not Recommended) Allow any extensions to
load without validation or warning.” You need to restart Power Bl Desktop.

6 ODBC client is automatically installed when you are installing Senturus Analytics Connector server. So,
you don'’t have to install ODBC client separately on the same computer.
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Connect via Custom Connector

Before using this connector, make sure you followed instructions in the Install the Custom
Connector section.

To begin, open Power Bl Desktop and select Get Data.
Find the Senturus Analytics Connector in the list.

Click Connect.

Get Data

Senturus x All

g Senturus Analytics Connector

All
Other

Certified Connectors Connect Cancel

Power BI will display a dialog where you can select the Server, Port, Database, and Data
Connectivity modes.

The Server, Port and Database lists are pulled from the configuration information in the
DataSourceConfig.xml file under the server’s Analytics Connector installation folder.

For the Data Connectivity mode, select DirectQuery.

Click OK.

© 2019-2022 Senturus, Inc.
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Senturus Analytics Connector

Server
Port

Database

Data Connectivity mode (i
Import
® DirectQuery

oK Cancel

An authentication dialog will appear. Type in your Cognos credentials, then click Connect.

Senturus Analytics Connector X

% Senturus Analytics Connector

User name

Password

Back Connect Cancel

NOTE: Power Bl desktop will securely store these credentials and skip this dialog if you select the
same Server and Database in a future connection.

To manage or delete the stored authentication information, go to File 2 Options and settings 2>
Data source settings.

Once connected to the Senturus Analytics Connector data source, the Navigator window will
display.

Select the tables you wish to include.

Click Load.
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Navigator

Display Cptions ~
4 Cognos_Senturus: GO Sales (query) [1]
4 GO Sales (query) [11]
Connector Reports
Filters and calculations

Inventary (query)

I
I
I
I nsl
I ns2
[ Product forecast (query)
[ Returned items (query)
3 root
P Sales [query) [14]
I AAA_CALCULATIONS

¥ E Branch
Order
Order method
Parameterized Products
Parameterized Products 2
Products

Retailer type

BEHBAHE@AAA

Retailers

L Branch

D" Preview downloaded on Thursday, October 4, 2018

_LINK_COLUMN_  Branch code

W oo ;b s Wk ke

Address 1
& 75, rue du Faubourg St-Honoré
7 Piazza Duomo, 1
9 Singelgravenplein 4
13 Schwabentor 35
14 LeocpoldstraBe 36
15 Isafjordsgatan 30 C
17 7800, 756 - 6th Avenue. 5.W.
18 789 Yonge Street
19 1288 Dorchester Avenue
20 299 Yale Avenue
21 1288 South Barrington Ave.
22 10032 NW 186th
23 6c, rue de I'Egl’lse
24 Prol. Paseo de Iz Reforma No. 51
25 202-2-3 Hyakunincho
26 543-225 Asahi
28 2315 Queen’s Ave
29 Plaza de |a Constitucion, s/n
30 Avenida Paulista, 333
31 Kauppakatu 33
32 234-12, Kongdeok-Dong
33 10 Claymare Hill

Load

Edit

Address 1 {multis
75, rue du Fau
Fiazza Duomo
Singelgravenp
Schwabentor
Leopaoldstrae
Isafjordsgatan
7800, 756 - 6t
789 Yonge St
1288 Dorchest
259 Yale Aven
1288 South Ba
10032 NW 18t
Bc, rue de I'Eg
Prol. Paseo de
202237 A0
543-225 18
2315 Queen’s
Plaza de la Col
Avenida Paulis
Kauppakatu 3:
=55 2341
sEl 0!Y
>

Cancel

Power BI will then inspect the selected tables for column information.

Apply query changes

¢ Sales
Evaluating...
.= Time
Evaluating...
. Products
Evaluating...
it Branch
Evaluating...

Cancel

When complete, navigate to the Relationships view and creaste relationships among tables.
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Contact Us

The latest version of the Analytics Connector along with related documentation and contact
information can be found at hitps://www.senturus.net/connector-download/.

If you have any additional questions, please contact us at CustomerSupport@senturus.com.
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